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1 About SDN

The salient features of SDN are:

= Directly programmable: SDN decouples the network control and forwarding functions.
SDN allows programming the network control plane by abstracting the physical
infrastructure.

= Agile: Decoupling and abstracting network control from forwarding helps administrators
dynamically adjust network-wide traffic flow to meet the changing needs in the networks.

= Centrally managed: Network intelligence is centralized (logically) in software based SDN
controllers that maintain a global view of the network, which appear to applications and
policy engines as a single, logical switch.

= Programmatically configured: SDN lets network managers configure, manage, secure,
and optimize network resources very quickly via dynamic, automated SDN programs, which
they can write easily and quickly, because the programs do not depend on proprietary
software.

= Open standards-based and vendor-neutral: Because SDN is implemented through open
standards, SDN simplifies network design and operation because instructions are provided
by SDN controllers instead of multiple, vendor-specific devices and protocols.
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2 SDN in NetSim

SDN is available in NetSim from version 11 onwards. NetSim 'simulates’ OpenFlow protocol.
OpenFlow is an open interface to remotely control the forwarding tables in network switches,

routers, etc.
2.1 SDN Controller in NetSim

An SDN controller is an application in SDN that manages flow control to enable intelligent
networking. SDN controller can be used to control the packet forwarding of all Layer 3 devices in

the network.

SDN controller lies between the network devices and the applications. Any communication

between applications and devices must go through the controller.

NetSim has inbuilt controllers that 'simulate’ SDN. An SDN controller in NetSim contains a
Command Line Interface (CLI) to allow you to configure properties, such as, the IP forwarding

table for different devices in the network.

NetSim also provides a platform whereby users can develop various kind of commands/interface

compatible to any SDN enabled device.

In NetSim, any Layer 3 device can be configured as an SDN Controller. Multiple controllers can
be configured in a network scenario. The following is a list of Layer 3 devices you can configure
as an SDN controller:

= Internetworks — Nodes (Wired, Wireless Node),Routers

= MANETs — Nodes (Wired, Wireless Node), Bridge Node (Wired, Wireless Node), Routers
= WSN - Sensors and Sink Node

= |OT - Sensors and Gateway (LowPAN Gateway), Nodes (Wired, Wireless Node), Routers
= Cognitive Radio — CR CPE, Nodes (Wired, Wireless Node), Routers

= LTE - UE, EPC, Nodes (Wired, Wireless Node), Routers

= VANETSs - Vehicle and RSU

= 5G mmWave — UE, Nodes (Wired, Wireless Node), Routers

NOTE: NetSim ‘simulates’ SDN protocol and cannot connect to real controllers such as Open Daylight.
2.2 CLI Commands for SDN in NetSim

You can use the following commands when you simulate SDN in NetSim:

Simulation-specific — Pause, PauseAt, Continue, Stop, Exit, and Reconnect.

Route — route add, route print, and route delete.
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Ping Command - ping (not supported on some network types, for example, Wireless Sensor
Network)
ACL configuration — ACL Enable, ACL Disable, ACL Print, and aclconfig.

Notes: CLI commands in NetSim are NOT case-sensitive. To get detailed help about how to use
CLI commands in NetSim, see Section 3.14 NetSim Interactive Simulation in User Manual.

2.3 Configuring SDN in NetSim

SDN protocol parameters can be accessed and configured from the Application layer properties

of the devices.

¢ Open-flow protocol must be enabled in the devices which are configured as SDN Controller

or SDN clients.
o SDN Controller device must have the SDN Controller option set to True.

e SDN Client devices must have the SDN Controller option set to False along with the

Controller Device Name set as the SDN Controller Device Name.
e Interactive Simulation option needs to be set to True in the Run time interaction tab.

When SDN commands are executed during runtime either via console or via file input, commands

and response are exchanged between the controller and clients using TCP.
2.4 How to use CLI Commands for SDN

Each device in NetSim has a console which can be accessed by right clicking on the device.
Users can execute supported SDN commands on the console of the SDN controller node to
configure other nodes in the network. Let us look at a few examples.

Example 1: To view the IP routing table of a node that is controlled by the SDN controller, use

the following command syntax: <DeviceName with Device ID> route print.
For example, type Wired_Node_2 route print and press Enter.

The following image illustrates the output for the command.
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B C:\Program Files\NetSim\Pro_v14_2\bin\NetSimCLl.exe — [m] X

Figure 2-1: Printing IP routing table in Console
Example 2: To initiate ping from one node to another node where both nodes are controlled by
the SDN controller, following command can be executed in the SDN controller:
<DeviceName with Device ID> Ping <DeviceName with Device ID> or <DeviceName with
Device ID> Ping <IP Address>.

For example, type Router 3 ping Router 4 or Router 4 ping 11.0.0.2 and press Enter.

B Ch\Program Files\MetSim\Pro_v14_2\bin\NetSimCLlLexe — O *

Reply from 11
Reply from 1:
Reply from 11
Reply from 1:

MR R

NetSim>Router_4 ping 11.8.0.2
lidated
to ¢
.8

Repl? from 1:
Reply from 11
Reply from 1:

NetSim>»g

Figure 2-2: Pinging Router 4
NOTE: In order to initiate ping between the devices, ICMP protocol which is present in the Network Layer

properties of the devices must be set to TRUE.
2.5 Excluded Features

Multiple controllers can be configured in NetSim. However, intercontroller communication requires

the user to write their own code in NetSim.
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2.6 Troubleshooting issues in executing SDN commands

When executing SDN commands in the SDN controller, there can be cases where there is no
response coming back. Some of the reasons for this are listed below:

e SDN Controller and SDN client are unable to communicate (not reachable).
o Part of two different networks
o Due to the distance between the devices in the case of wireless nodes
¢ Failed TCP connection attempts due to high error or collision

o Commands for Controller to the client and response from the client to the controller are

passed as TCP packets.
o The TCP connection attempt fails if the maximum connection attempt is reached.
¢ High network traffic due to application packets exchanged during the simulation
Some suggestions to resolve issues with SDN command execution are listed below:
e Connectivity between the SDN controller and clients should be ensured.

e Application start time can be increased to allow necessary SDN commands to be executed
prior to application traffic flow which will also avoid contention especially in the case of

Wireless devices.

¢ SDN commands can be passed as input via file-based interactive simulation for higher

accuracy in terms of the time at which the commands are to be executed.

© TETCOS LLP. All rights reserved Page 8 of 31
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3 Featured Examples

NetSim provides inbuilt examples to get started with the SDN module. To access these examples,
you can go to Examples > Software-Defined-Networks in the NetSim Home Screen. You can
change the default values of the parameters in these examples and see how they affect the

performance of the SDN network.

3.1 Configuring SDN

3.1.1 Configuring One SDN Controller in a Simple Internetwork

The Internetwork model in this example consists of the following configuration:

1. A subnet with 2 wired nodes, 3 routers, and a unicast application running on one of the wired
nodes.

Only one router is configured as the SDN controller.

Open Flow protocol is enabled on all wired nodes and routers.

A unicast application is set between Wired Node 1 to Wired Node 2.

Set Transport Protocol to TCP in Application Properties.

Simulation time is set to 500 seconds.

N o o bk~ wDd

Packet trace is enabled.

To simulate the example for One SDN controller in an Internetwork:

Open NetSim and Select Examples > Software Defined Networks > Configuring SDN > SDN
Internetworks then click on the tile in the middle panel to load the example as shown in below

[ NetSim Home = X
NetSim Professional
Network Simulation/Emulation Platform
Version 14.2.8 (64 Bit)

New Simulation CirlsN  Example Simulations SDN Internetworks Results
Vour Work Cer+0 internetworks A& simple example with invalving one SDN controller. This exemple is developed in the
[ xampes b ¥ Advanced Routing intemetworks library.
) Mobile Adhoc Networks — .
Experiments 4 Software Defined Networks

4 Configuring SON st omen o ol
nabled open flow in all devices
P 2S Changed SDN cantroller device name

WSN Sefting Multiple SON Controllers Transport protocok TCP
MANET StaticRoute
Internetworks StaticRoute

WSN StaticRoute

IOT-WSN

Cognitive Radio Networks
LTE and LTE-A

VANETs

Satellite Communication

56 NR

TDMA Radic Networks
Undenwater Acoustic Netwark

License Setting:
Eat AlrsF4
Ready to simulate scenarios to Understand the warking of the different technalagy libraries in NetSim, Expand and click on the file name to display simulation examples. Then dick an 2 tile in the middle panel to load the
simulation. Click on the bock icon on the left (Example Simulations) panel to view documentation (pdf.
Support Lean Documentation Contact Us

Email - sales@tetcos.com
Phone - +91 767 605 4221
Website

Figure 3-1: List of scenarios for the example of SDN Internetworks
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The following network diagram illustrates what the NetSim Ul displays when you open the
example configuration file for SDN as shown Figure 3-2.

4

SDN_Centroller

-
App1_CBR

Wired_Node_1 Wired_Node_2

Figure 3-2: Network set up for studying the SDN Internetworks
1. In the application layer of the SDN Controller node:

a. SDN Controller option set to TRUE.

b. Open Flow protocol is enabled.

The following image illustrates the settings done in the SDN controller device:

D‘— SDN_Controller Properties - X

AN O B

&> General
> Position

4 Application Layer

4 Open Flow

Open Flow Enable TRUE h
SDN Controller TRUE v
> OSPF

> Transport Layer
> Network Layer
> Interface_1 (WAN)
> Interface_2 (WAN)

Figure 3-3: Application Layer properties Window of SDN_Controller device

2. Inthe other devices (Routers and wired node) that are part of the network,

a. SDN Controller option is set to FALSE.
SDN Controller DeviceName is set as “SDN Controller” which is the name of the
controller node.

c. Open Flow protocol is enabled.

The following image illustrates settings done in the other devices:
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q Wired_Node_1 Properties — x

AN O =™

& General
& Position

4 Application Layer

4 Open Flow

Open Flow Enable TRUE v
SDN Controller FALSE v
SDN Controller Device Name SDN_Controller

& Transport Layer
& Network Layer
> Interface_1 (Ethernet)

Figure 3-4: SDN Controller DeviceName is set as SDN Controller in Application layer

The following table lists the settings done in all the devices that are part of the network:

Device Name Open Flow SDN Controller SDN Controller DeviceName
Wired Node 1 Enable FALSE SDN Controller

Router 3 Enable FALSE SDN Controller

SDN Controller Enable TRUE NA

Router 5 Enable FALSE SDN Controller

Wired Node 2 Enable FALSE SDN Controller

Table 3-1: Set the properties for all the devices

3. Configure an application between any two nodes in the scenario by selecting an application
from the Set Traffic tab.

a. CBR Application from Wired Node 1 to Wired Node 2 with 50 Mbps Generation Rate
(Packet Size: 1460Bytes, Inter Arrival Time: 233.6s).
b. Set Transport Protocol to TCP.

4. Before simulating the example, Right-click SDN Controller and select NetSim Console. Now,
the client (NetSimCLIl.exe) waits to establish a connection with NetSimCore.exe as shown

below.

B ChProgram Files\MetSim Prot\biniMetSimCLLexe

...Initialise:
DESKTOP- Lt
1

MetSim>

Figure 3-5: Connection Establishment

5. Follow the below steps to simulate an example.
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a. Click on the Options tab. Select Run time interaction.

N Fie

.}"{gf Create
B Save
<—::| Close

File

Options ~ Help | Network: Internetworks | Workspace: 30ct2023

Open MATLAB Interface 2“5 Show/Hide Info

2] L2 Switch
| 13 switch

Switch

111 Configure Reports

Run Time Interaction
Static ARP

g
u g‘ Wireless Node

Wired Node

Run Simulation Node Access Point

= ® A

Ver 14.3

Router

Wired/Wireless Links

Figure 3-6: Run Time Interaction option in NetSim GUI

b. In the Run Time Interaction tab, set Interactive Simulation to True and click on OK.

Ei Runtime Interaction _ 0

NetSim allows users to interact with simulations at runtime via command execution to
view/modify certain device parameters during runtime.

There are two options available for runtime interaction. Interaction can be set to be via a
socket or through a ‘input.txt' file in a predefined format.

Interactive Simulation True v

File Name Input File Browse

oK Cancel

This input.txt file accepts all the commands that NetSim's interactive simulation supports.

X

Figure 3-7: Enable Interactive Simulation

c. Click on Run Simulation window and simulate it to 500 secs.

Ei NetSim - Run Simulation —

Simulation Time

Enter desired simulation time. Valid range is 0.0001 to 100,000 seconds.

500

Simulation Time

Seed Value

numbers in simulation.

Seed 1 | 12345678 Seed 2 23456789

Cancel

Enter seed value between 1 to 99,999,999. The seed values are used to generate random

Figure 3-8: Run Simulation Window

Simulation (NetSimCore.exe) starts to run. NetSimCore.exe displays the following message:

waiting for the first client to connect.

© TETCOS LLP. All rights reserved
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B Ch\Users\ALICE\Documents\NetSim\Workspaces\For_tail\bin_x64\NetSim Core.exe — ] =
tri "BER " nd in line n 15

INTERFACE/LAYER[3]/PROTOCOL/PROTOCOL_P

Figure 3-9: Waiting for first client to connect.

d. Use this console to execute SDN commands as explained in section 2.2.

3.1.2 Configuring Multiple SDN Controllers in a Wireless
Sensor Network

In this example, multiple SDN controllers are configured in a Wireless Sensor Network.
The Wireless Sensor Network model in this example consists of the following configuration:
= A subnet with 4 wireless sensors,1 ad-hoc link, 1 WSN sink node, and a unicast sensor
application running on one of the wireless sensors.
= Set Transport Protocol to TCP in Application Properties.
= Two wireless sensors are configured as SDN controllers.
= Open Flow protocol is enabled on all wireless sensors and sink node.

NetSim uses the following defaults for this SDN example:

a. The unicast application transmits data from Wireless Sensor 3 to Wireless Sensor 5.
b. Simulation runs for 500 seconds.
c. Packet trace is enabled.
NOTE: For a WSN network, ping command is not supported on ZigBee device since these nodes do not support ICMP

protocol.

To simulate the example for multiple SDN controllers in WSN for SDN:
Open NetSim and Select Examples > Software Defined Networks > Configuring SDN > WSN
Setting Multiple SDN Controllers then click on the tile in the middle panel to load the example

as shown in below screenshot

© TETCOS LLP. All rights reserved Page 13 of 31
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[ NetSim Home

NetSim Professional

Network Simulation/Emulation Platiorm
Version 14.2.8 (64 Bit)

New Simulation Ctri+N  Example Simulations WSN Setting Multiple SDN Controllers Results

Your Work Cri-Q Simulating multiple SDN controllers. This example is devioped for Wireless Sensor Networks

Examples WSN Setting Multiple SON Controllers

Experiments

s,
Enabled open flow in all devices «_.f
Changed SDN controller device name

= e Network layer protocol DSR

WSN Setting Multiple SDN Controllers Interactive simulation: TRUE
MANET StaticRoute

Internetworks StaticRoute

WSN StaticRoute

10T-WSN

Cognitive Radio Networks
LTE and LTE-A

VANETs 1

Satellite Communication

56 NR

TDMA Radio Networks
Underwater Acoustic Network

License Settings

Bt AlteF4
Ready to simulate scenarios to understand the working of the different technology ibraries in NetSim. Expand and click on the file name to display simulation examples. Then click on 3 file in the middle panel to load the
simulation, Click on the boak icon on the left (Example Simulations) panel to view documentation (pdf).

Support Lesrn Documentation Contact Us

Email - sales@tetcos.com
Phone - +01 767 605 4321
Website :

Figure 3-10: List of scenarios for the example of WSN Setting Multiple SDN Controllers

The following network diagram illustrates the network setup related to this example as shown
below Figure 3-11.

— == 1 Lln‘k‘l Y~ = bt
L=r 4 ~ S~
p——es ] > ! “ 1 T 4
s . 1 S =~ . _ [N
= . 1 s =
= L i RN =
SDN_Caontroller_Sens P 'l T SDN_Controller_Sens
ort X sl T or2
.
L ] ..
P = !
.~ SDN_Controller_Sink S
e Node S
4 ~
~
7 3 | A
@ App1_SENSOR_APP 5@
Wireless_Sensor_3 Wireless_Sensar_5

Figure 3-11: Network set up for studying the WSN Setting Multiple SDN Controllers
1. The SDN Controller Sensors, Wireless Sensors and the sinknode are configured as SDN
controllers with Open Flow protocol enabled in all the nodes.

The following image illustrates the settings done in the sensors configured as SDN controller
as shown below Figure 3-12.
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N

v v

[

\%

v

AN O -

General
Position

Application Layer

4 Open Flow

Open Flow Enable TRUE

SDN Controller TRUE

Transport Layer
Network Layer
Interface_1 (Zigbee)
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-

-

Figure 3-12: Application Layer properties Window

2. The sensor SDN Controller Sensor 1 is set as the SDN controller for Wireless Sensor 3

and SDN Controller Sensor 2 is set as the SDN controller for Wireless Sensor 5.

The following image illustrates the settings done in sensor 3 as shown Figure 3-13.

b
Bt

= General
= Position

4 Application Layer

4 Open Flow

Open Flow Enable TRUE

SDN Controller TRUE

= Transport Layer
> MNetwork Layer

> Interface_1 (Zigbee)

O x

Figure 3-13: SDN Controller DeviceName is set as SDN Controller in Application layer

The following table lists the default setting for the wireless sensors.

SDN Controller DeviceName

Device Name

SDN Controller Sink Node
SDN Controller Sensorl
SDN Controller Sensor2
Wireless Sensor3
Wireless Sensor5

© TETCOS LLP. All rights reserved

Open Flow SDN Controller
Enable TRUE

Enable TRUE

Enable TRUE

Enable FALSE

Enable FALSE

NA

NA

NA

SDN Controller Sensorl
SDN Controller Sensor2
Table 3-2: Set the properties for all the devices
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3. Configure an application between any two nodes in the scenario by selecting an

application from the Set Traffic tab.

a. Sensor Application from Wireless Sensor 3 to Wireless Sensor 5 with Packet Size:
50Bytes, Inter Arrival Time: 1000000ps).
b. Set Transport Protocol to TCP.

4. Packet trace is enabled under configure reports tab.
5. To use the SDN CLI Console:

a. Right-click SDN Controller Sensorl or SDN Controller Sensor2 and click NetSim
Console. Now, the client (NetSimCLI.exe) starts and tries to establish a connection with

NetSimCore.exe.

The following image illustrates the NetSim CLI console.

B Ch\Program Files\MetSim'\Pro_v14_2\bin\Net5imCL|Lexe

2 Initialised.
DESKTOP-MOUQVAS .

Figure 3-14: Connection established.
6. Simulate the example. To do so:

a. Click on the Options tab. Select Run time interaction.

w File  Options Help | Network: Internetworks | Workspace: 30ct2023

J Create| Open MATLAB Interface 11l Configure Reports % Show/Hide Info
; Run Time Interaction | —
B Save Siatic ARP Wired Node 3 L2 Switch @ OQ\
o % =
F:] Close N\ g Wireless Node \‘*‘) L3 Switch e
File Run Simulation Node Switch Access Point Router Wired/Wireless Links

Figure 3-15: Run Time Interaction in NetSim GUI
b. In the Run time Interaction tab, Interactive Simulation option is set to True and click on
OK.
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NetSim allows users to interact with simulations at runtime via command execution to
view/modify certain device parameters during runtime.

There are two options available for runtime interaction. Interaction can be set to be via a
socket or through a 'input.txt’ file in a predefined format.

This input.txt file accepts all the commands that NetSim's interactive simulation supports.

Interactive Simulation True

File Name nput File

OK Cancel

X

Figure 3-16: Runtime Interaction window

c. Click on the Run Simulation window and simulate it to 500 sec.

1-: NetSim - Run Simulation

Simulation Time
Enter desired simulation time. Valid range is 0.0001 to 100,000 seconds.

Simulation Time | 50q

Seed Value

Enter seed value between 1 to 99,999,999. The seed values are used to generate random
numbers in simulation

Seed 1 12345678 Seed 2 | 23456789

Run Cancel

Figure 3-17: Run Simulation Window

Ver 14.3

CAUsers\ALICE\Documents\NetSim'\Workspaces\For_tail\bin_x64\NetSimCore.exe
ttribute "BER_MODEL" i

found in line number

/INTERFACE/

omplete

Figure 3-18: Waiting for first Client to Connect

You can execute various SDN commands that are supported in any of the SDN controller Sensor

CLI in Figure 3-14.

© TETCOS LLP. All rights reserved
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3.2 Configuring Static Routes for a MANET Network by using

SDN

In this example static routes are configured using the SDN controllers, in a MANET network.

The MANET network model in this example consists of the following configuration:

A subnet with 5 wireless nodes and 1 ad-hoc link, and a unicast CBR application running
on one of the wireless nodes.

DSR is the routing protocol that is enabled on all wireless nodes.

One wireless node is configured as the SDN controller.

Wireless nodes do not have mobility.

A unicast application is configured from Wireless Node 1 to Wireless Node 5.

Simulation time is set to 500 seconds.

Packet trace is enabled.

To simulate the example for MANET using SDN:

Open NetSim and Select Examples > Software Defined Networks > MANET StaticRoute then

click on the tile in the middle panel to load the example as shown in below screenshot

[ NetSim Home - =] X
NetSim Professional
Network Simulation/Emulation Platform
Version 1428 (64 Bit)
New Simulation CtdeN  Example Simulations MANET StaticRoute Results
Yous Wod Q0 Internetworks In this example, static routes are configured using the SDN controllers, in a MANET network
Advanced Routin
Examples 9
MANET StaticRoute
Mobile Adhoc Networks o
Experiments 4 Software Defined Networks
Enabled open flow in l devi
Changed SDN controller
+ protocol: DSR
1OT-WSN
Cognitive Radio Networks
LTE and LTE-A
VANETs
Satellite Communication
5GNR
TDMA Radio Networks
Undenwater Acoustic Network
L 1se Setting:
Bat Alt+F4
Ready to simulate scenarios to understand the working of the different technology libraries in NetSim. Expand and click on the file name to display simulation examples. Then click on a tle in the middle panel to load the
simulation. Click on the book icon on the left (Example Simulations) panel to view documentation (pdf
Support Leam Documentation Contact Us

Email - sales@tetcos.com
Phone - +91767 605 4321
Website

Figure 3-19: List of scenarios for the example of MANET StaticRoute

The following network diagram illustrates the network setup as shown Figure 3-20.
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Ll g F
- __ QAP - =

1 o---" S-——— 1 —

Wireless_Node_2 SRS T 7= ~-____ SDN_Controller

N 1 1 N

Q RopTLCoR Q

Wireless_ Node_1 Wireless_Node_5

Figure 3-20: Network set up for studying the MANET Static Route

DSR routing protocol is configured in Network layer for all the nodes and set the nodes to
be stationary.

Mobility model is set to NO MOBILITY in all the nodes.

ICMP protocol is enabled in the network layer properties of all the wireless nodes.

Open flow protocol is enabled in all the wireless nodes.

The following settings were done in the wireless nodes to configure Wireless Node 4 as SDN

controller and other nodes as its clients.

Device Name Open Flow SDN Controller SDN Controller DeviceName
Wireless Node 1 Enable FALSE SDN Controller

Wireless Node 2 Enable FALSE SDN Controller

Wireless Node 3 Enable FALSE SDN Controller

SDN Controller Enable TRUE N/A

Wireless Node 5 Enable FALSE SDN Controller

Table 3-3: Set the properties for all the devices
Configure an application between any two nodes in the scenario by selecting an application
from the Set Traffic tab.

a. CBR Application from Wireless Node 1 to Wireless Node 5 with 0.584 Mbps Generation
Rate (Packet Size: 1460Bytes, Inter Arrival Time: 20000us).
b. Set Transport Protocol to UDP.

Click on link , expand the right-side property panel and set Channel Characteristics: Path
Loss Only, Path Loss Model: Log Distance, Path Loss Exponent: 2.5.

In NetSim Packet Trace is enabled under configure reports tab.

To use the SDN CLI Console:

a. Right-click SDN Controller and select NetSim Console. Now, the client (NetSimCLI.exe)

starts and attempts to establish a connection with NetSimCore.exe.
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B Ch\Program Files\MetSim\Pro_v14_2\bin\MetSimCL]Lexe

nitialise
0P - Mgy

Figure 3-21: Connection established.
5. Simulate the example. To do so:

a. Click on the Options tab. Select Run time interaction.

ﬁ File Options Help | Network: Internetworks | Workspace: 30ct2023
Ji Create. Open MATLAB Interface 111 Configure Reports % Show/Hide Info

Run Time Interaction | —

v - - .
B Save Static ARP Wired Node =9 L2 Switch @ a\
(%) 13 suitch H

L E
ﬂ Close &/ g Wireless Node

File Run Simulation Node Switch Access Point Router Wired/Wireless Links

Figure 3-22: Runtime Interaction in GUI

Ver 14.3

b. In the Run time Interaction tab, Interactive Simulation option is set to True and click on

OK.

[ ¥ Runtime Interaction - O X

NetSim allows users to interact with simulations at runtime via command execution to
view/modify certain device parameters during runtime.

There are two options available for runtime interaction. Interaction can be set to be via a
socket or through a 'input.txt' file in a predefined format.

This input.txt file accepts all the commands that NetSim's interactive simulation supports.

Interactive Simulation True v

File Name Input File Browse

OK Cancel

Figure 3-23: Enabling Run Time Interaction option.

c. Click on Run simulation window and simulate it to 500 sec.

E NetSim - Run Simulation — X

Simulation Time
Enter desired simulation time. Valid range is 0.0001 to 100,000 seconds.

Simulation Time | 50|

Seed Value
Enter seed value between 1 to 99,999,999. The seed values are used to generate random
numbers in simulation.

Seed 1 12345678 Seed2 | 23456789

Run Cancel

Figure 3-24: Run Simulation window

© TETCOS LLP. All rights reserved

Page 20 of 31



Ver 14.3

Simulation (NetSimCore.exe) starts to run. NetSimCore.exe displays the following message:

waiting for the first client to connect.

B CAUsers\ALICE\Documents\NetSim'\Workspaces\For_tail\bin_x64'\NetSimCore.exe - O e
INTERFACE/LAYER[3]/PROTOCOL/PROTOCOL_P|
t value and proceeding
Error in config file ---

A bute
INTERFACE/LAYER[3]/PROTOCOL/PROTOCOL_P|

found in line number 7
SIM/NETWORK_CONFIGURAT ! INTERFACE/LAYER[3]/PROTOCOL/PROTOCOL_P|

tiali
ole Mode is en
ng for first client to connect. Press ctrl+c to stop connection.

Figure 3-25: Waiting for the first Client to connect.

6. Interpret the Results

a. In the simulation results window select the Traces option in the left area and open the
packet trace file. Once the packet trace opens apply filter in the CONTROL PACKET
TYPE/APP NAME for APP1 CBR.

b. The packets reach Wireless Node 5 from Wireless Node 1-> Wireless Node 3-> Wireless

Node 5.
PACKET_ID|-¥| SEGMENT_ID ~ |PACKET_TYPE| - |CONTROL_PACKET_TYPE/APP_NAME -Y SOURCE_ID ~ DESTINATION_ID| ~ TRANSMITTER_ID| ~ |RECEIVER_ID ~
1 0 CBR Appl CBR NODE-1 NODE-5 NODE-1 NODE-3
1 0 CBR Appl_CBR NODE-1 NODE-5 NODE-3 NODE-5

Figure 3-26 : Packet trace screenshot

7. For the same example, configure static routes such that the packets will go through Wireless
Node 1 > Wireless Node 2, Wireless Node 3, SDN Controller to Wireless Node 5. To

configure the static routes on SDN Controller for all the nodes.

a. Right-click SDN Controller and select NetSim Console.

b. Re- run the simulation.

c. Type the following commands on the NetSim CLI console, in the <DeviceName with

Device ID> route add <destination IP address> MASK <subnet mask> <gateway |IP
address> <metric> if <interface #> format.
Wireless Node 1 route ADD 192.168.0.6 MASK 255.255.255.0 192.168.0.3 METRIC 1 IF 1
Wireless Node 2 route ADD 192.168.0.6 MASK 255.255.255.0 192.168.0.4 METRIC 1 IF 1
Wireless Node 3 route ADD 192.168.0.6 MASK 255.255.255.0 192.168.0.5 METRIC 1 IF 1
SDN Controller route ADD 192.168.0.6 MASK 255.255.255.0 192.168.0.6 METRIC 1 IF 1
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B C\Program Files\NetSim'\Pro_v14_2\bin\MetSimCLLexe

NetSim>stop

NetSim>

8. Interpret the Results.

.8.6

3 METRIC

METRIC

METRIC

1IF1

1IF1

1IF1

METRIC 1 IF 1

Figure 3-27: NetSim Console Window

a. Open Packet trace and filter CONTROL PACKET TYPE/APP NAME to APP1 CBR, you

will see that data packets transmitted from Wireless Node 1 > Wireless Node 2 > Wireless

Node 3 > SDN Controller to Wireless Node 5 as part of the commands executed for static

route configuration.

PACKET_ID |+ |SEGMENT_ID
2185
2185
2185
2185
2186
2186
2186
2186
2187
2187
2187
2187
2188
2188
2188
2188
2189
2189
2189
2189
2190
2190
2190
2190
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0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR
0 CBR

T S v | DESTINATION ID | v | TR/ T v |RECEIVERID |~
App1 CBR NODE-1 NODE-5 NODE-1 NODE-2
App1_CBR NODE-1 NODE-5 NODE-2 NODE-3
App1_CBR NODE-1 NODE-5 NODE-3 NODE-4
App1_CBR NODE-1 NODE-5 NODE-4 NODE-5
App1_CBR NODE-1 NODES NODE-1 NODE-2
Appl_CBR NODE-1 NODE-5 NODE-2 NODE-3
Appl_CBR NODE-1 NODE-5 NODE-3 NODE-4
Appl_CBR NODE-1 NODE-5 NODE-4 NODE-5
Appl_CBR NODE-1 NODE-5 NODE-1 NODE-2
App1_CBR NODE-1 NODE-5 NODE-2 NODE-3
App1_CBR NODE-1 NODE-5 NODE-3 NODE-4
App1_CBR NODE-1 NODE-5 NODE-4 NODE-5
Appl_CBR NODE-1 NODE-5 NODE-1 NODE-2
App1_CBR NODE-1 NODE-5 NODE-2 NODE-3
App1_CBR NODE-1 NODE-5 NODE-3 NODE-4
Appl _CBR NODE-1 NODE-5 NODE-4 NODE-5
Appl_CBR NODE-1 NODE-5 NODE-1 NODE-2
Appl _CBR NODE-1 NODE-5 NODE-2 NODE-3
App1_CBR NODE-1 NODE-5 NODE-3 NODE-4
Appl_CBR NODE-1 NODE-5 NODE-4 NODE-5
App1_CBR NODE-1 NODE-5 NODE-1 NODE-2
Appl1 CBR NODE-1 NODE-5 NODE-2 NODE-3
Appl_CBR NODE-1 NODE-5 NODE-3 NODE-4
Appl_CBR NODE-1 NODE-5 NODE-4 NODE-5

Figure 3-28: Packet Trace Window
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3.3 Configuring Static Routes for Internetworks using SDN

In the example the IP tables in the nodes and routers on an SDN network are modified using SDN
CLI commands.
The network model in this example consists of the following configuration:
= A subnet with 2 wired nodes, 5 routers, and a unicast application running on one of the
wired nodes.
= SDN controller running on one of the router.
= Set Transport Protocol to TCP in Application. Open Flow protocol is enabled on all wired
nodes and routers.
= A unicast application set from Wired Node 1 to Wired Node 2.
= QOSPF is the routing protocol in the routers.
= The node SDN Controller is configured to be the SDN controller.
= Simulation time is set to 500 seconds.
= Packet trace, and Event trace are enabled.
To simulate SDN and change the IP tables:
Open NetSim and Select Examples > Software Defined Networks > Internetworks
StaticRoute then click on the tile in the middle panel to load the example as shown in below

[ Netsim Home - lu] X
NetSim Professional
Network Simulation/Emulation Platform
Version 14.2.8 (64 8it)

Internetworks StaticRoute Results

In the example, the IP tables in the nodes and routers on an SDN netnork are modified using

SDN CLI commands.
Examples

Intermetworks StaticRoute

Experiments

WSN StaticRoute
b 1 IOT.WSN &

I | Cognitive Radio Networks

b1 Satelite Communication
v 1 SGNR

b TOMA Radi Networks

b Undenwater Acoustic Network

Tyme e fowing commareds < fha NotSim CLI ccrucl, i e <Devicetiaris weh

License Settings owee.
crotrics W intctace B frm. ousis 3 route ADD 18216802 MASK

sckenss <
Exit At+F4 2652952680 11,002 METRIC 1 7 2

Rezdy to simulate scenarios to understand the working of the different technology ibraries in NetSim, Expand and click an the file name to disglay simulation examples. Then click on a tile in the middle panel to load the
simulation. Click on the book icon on the left (Example Simulations) panel to view documentation (pd)

Support Learn Documen tation

767 605 4321
Website :

Figure 3-29: List of scenarios for the example of Internetworks StaticRoute

The following network diagram illustrates the network setup related to this example as shown

below Figure 3-30.
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Figure 3-30: Network set up for studying the Internetworks Static Route
1. Configure an application between any two nodes in the scenario by selecting an application
from the Set Traffic tab.

a. CBR Application from Wired Node 1 to Wired Node 2 with 50 Mbps Generation Rate
(Packet Size: 1460Bytes, Inter Arrival Time: 233.6us).
b. Application Start time is 30 sec.

c. Set Transport Protocol to TCP.

Packet Trace and Event Trace features are enabled from Configure Reports.
3. To use the SDN CLI: Right-click SDN Controller and select NetSim Console. Now, the client
(NetSimCLI.exe) starts and attempts to establish a connection with NetSimCore.exe.

B ChProgram Files\MetSim Prot\biniMetSimCLLexe

Connection established.

MNetSim:

Figure 3-31: Connection Establishment.

4. Simulate SDN. To do so,

a. In the Run time Interaction under options tab, Interactive Simulation option is set to True.
b. Click the Run button. The Run Simulation pop-up window appears.

c. Simulation time is set to 500 Seconds.
5. Interpret the results.

a. Open packet trace and filter the CONTROL PACKET TYPE/APP NAME to APP1 CBR,
and PACKET ID to 1. Packets reach Wired Node 2 via Wired Node 1 > Router 3 > SDN

Controller > Router 6 as shown in Figure 3 15.
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- B CONTROL_PACKET_TYPE/APP_NAME E4 SOURCE_ID S - -
1 0 CBR Appl_CBR NODE-1 NODE-2 NODE-1 ROUTER-3

1 0 CBR Appl_CBR NODE-1 NODE-2 ROUTER-3 ROUTER-7
1 0 CBR Appl CBR NODE-1 NODE-2 ROUTER-7 ROUTER-6
1 0 CBR Appl_CBR NODE-1 NODE-2 ROUTER-6 NODE-2

Figure 3-32: Packet Animation window
6. Click View Results on the tool bar, Link metrics in the left area and check the Detailed View
check box in the Link Metrics Table pop-up window. You will not see data packet

transmissions in links 2, 3, and 4 as shown in below Figure.

Link Metrics
Performance of both wired and wireless network connections.
Packets Transmitted Packets Errored Packets Collided
Link ID Bytes Transmitted Payload Transmitt Overhead Transm
Data Control Data Control Data Control
All 28779 28841 40 2 0 0 45077438 41958940 3118498
1 721 nmn 10 ] 0 0 11477280 10513460 963820
2 0 29 0 o 0 0 2652 ) 2652
3 0 29 o ] 0 0 2576 0 2576
4 0 34 o 1 0 0 3208 0 3208
5 7179 772 10 o 0 0 11428514 10466740 961774
6 7200 7203 10 o 0 0 11089916 10497400 592516
7 7189 7203 10 1 0 0 11073292 10481340 591952

Figure 3-33: Link Metrics table in Result Window
7. For the same example, configure static routes on Router 3 such that all traffic bound for the
11.0.0.18 subnet will go to a gateway 11.0.0.2, that is, from Router 3 > Router 4 > Router 5
> Router 6.

To configure the static routes for Router 3:

Simulate the network again by following below steps

b. Now, right-click SDN Controller and click NetSim Console.

c. Now, the client (NetSimCLl.exe) starts and attempts to establish a connection with
NetSimCore.exe. NetSim CLI console opens.

d. Type the following commands on the NetSim CLI console, in the <DeviceName with
Device ID> route add <destination IP address> MASK <subnet mask> <gateway IP
address> <metric> if <interface #> format.

Router 3 route ADD 192.169.0.2 MASK 255.255.255.0 11.0.0.2 METRIC 1 IF 2
e. (Optional) To check the static routes on ROUTER 3, type ROUTER 3 route print. The

following image illustrates step (c) and (d) as shown below Figure 3-34.
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B’ C\Program Files\NetSim\Pro_v14_2\bin\NetSimCL|.exe

Interface
11.0.

Figure 3-34: Route added to network and route printed in command.
8. Interpret the results.

Click packet trace from the results dashboard.
b. The packets reach Wired Node 2 via Router 3 > Router 4 > Router 5 > Router 6.
c. Click Link metrics in the left area and check the Detailed View check box in the Link

Metrics Table pop-up window.

You will see data packet transmissions in Links 2, 3, and 4.

The following figure illustrates step (7c¢) as shown in below.

Link Metrics
Rerformance of both Wired snd wireless network connacion

Link ID Fackets Transmittd Packsts Errored Packets Collided Bytes Transmitted Payload Transmitt Overhead Transm
Data Control Data Control Data Control
All 200902 161477 264 8 0 0 312025546 292933866 19091680
1 40590 40321 53 2 0 0 64601534 59184020 5417514
2 39000 n 47 0 0 0 58502788 56871380 1631408
3 38053 33 47 0 0 0 58432396 56802760 1629636
4 38906 38 54 1 0 0 58362528 56723920 1638608
5 40384 40326 61 2 0 0 64287508 58871580 5415928
6 1535 40370 1 0 0 3921720 2242026 1679694
7 1534 40358 2 0 o 3917072 2238180 1678892

Figure 3-35: Link Metrics Table
d. In the simulation results window click on the Open Packet trace option in the left area.

Once the packet trace opens, apply display filters to the

CONTROL PACKET TYPE/APP NAME column to show only OPENFLOW COMMAND

and OPENFLOW RESPONSE packets.
You will see that OpenFlow packets flow between Router 3 to SDN Controller.

9. In Router 3 under application layer use routing protocol as RIP

10. Configure static routes for Router 3 as follows:

a. Simulate SDN (Refer step 4).
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b. Right-click SDN Controller and click NetSim Console.

Ver 14.3

Now, the client (NetSimCLl.exe) starts and tries to establish a connection with

NetSimCore.exe. NetSim CLI console opens.

c. Type the following commands on the NetSim CLI console, in the <DeviceName with

Device ID> route add <destination IP address> MASK <subnet mask> <gateway IP

address> <metric> if <interface #> format.

Router 3 route ADD 192.169.0.2 MASK 255.255.255.0 11.0.0.26 METRIC 1 IF 2

a. Click View Packets and see the Packet Trace. The packets reach Wired Node 2 via

Router 3 > SDN Controller > Router 6.

PACKET_ID| ~ |SEGMENT_ID ~ PACKET_TYPE|~ CONTROL_PACKET_TYPE/APP_NAME -¥ SOURCE_ID ~ DESTINATION_ID v TRANSMITTER_ID ~ |RECEIVER_ID ~

0 CBR

Aopl CBR

NODE-1

NODE-2

NODE-1

1 0 CBR Appl CBR NODE-1 NODE-2 NODE-1 ROUTER-3
1 0 CBR Appl_CBR NODE-1 NODE-2 ROUTER-3 ROUTER-7
1 0 CBR Appl_CBR NODE-1 NODE-2 ROUTER-7 ROUTER-6
1 0 CBR Appl CBR NODE-1 NODE-2 ROUTER-6 NODE-2

2 0 CBR Appl_CBR NODE-1 NODE-2 NODE-1 ROUTER-3
3 0 CBR Appl _CBR NODE-1 NODE-2 NODE-1 ROUTER-3
2 0 CBR Appl _CBR NODE-1 NODE-2 ROUTER-3 ROUTER-7
3 0 CBR Appl_CBR NODE-1 NODE-2 ROUTER-3 ROUTER-7
2 0 CBR Appl CBR NODE-1 NODE-2 ROUTER-7 ROUTER-6
3 0 CBR Appl_CBR NODE-1 NODE-2 ROUTER-7 ROUTER-6
2 0 CBR Appl_CBR NODE-1 NODE-2 ROUTER-6 NODE-2

3 0 CBR Appl CBR NODE-1 NODE-2 ROUTER-6 NODE-2

4 0 CBR Appl _CBR NODE-1 NODE-2 NODE-1 ROUTER-3
5

ROUTER-3

Figure 3-36: Packet flow in trace file after executing the static routes for Router 3

3.4 Configuring Static Routes for a WSN Network by using

SDN

In this example static routes are configured in sensors using SDN commands executed in a SDN

controller.

The WSN network model in this example consists of the following configuration:

To simulate the example for WSN using SDN:

A subnet with 5 wireless sensor, 1 ad-hoc link, 1 wireless sink node, and a unicast sensor

application running on one of the wireless sensors.

One wireless Sensor is configured as the SDN controller.

A unicast application from Wireless Sensor 1 to Wireless Sensor 5.

Simulation time of 500 seconds.

Packet trace is enabled.

Open NetSim and Select Examples > Software Defined Networks > WSN StaticRoute then

click on the tile in the middle panel to load the example as shown in below screenshot
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[ Netsim Home - =] X

NetSim Professional
Network Simulation/Emulation Platform
Version 14.2.8 (64 Bit)

New Simulation CedsN Example Simulations WSN StaticRoute Results
Your Work Cul-0 Int rks In this example, static routes are configured in sensors using SDN commands executed in an
| Bamples Advanced Routing SN controller.

Mobile Adhoc Networks

WiSN StaticRoute o~
Experiments 4 Softvare Defined Networks He
Sonligemng SN Enabled open flow in all devices
MANEE Stabchoote Changed SDN controller device name & Elaik
Internetworks StaticRoute Transport protocol: UDP 5.5 ] 3 =2
Static route configuration via CLI & =8 &
TOT-WSN ; 2
Cognitive Radio Networks &
LTE and LTE-A =
VANETs
Satellite Communication
SGNR

TDMA Radio Networks
Undenwater Acoustic Network

License Settings

Exit Alt+F4

Ready to simulate scenarios to understand the wrking of the different technology fibraries in NetSim. Expand and click on the file name to display simulation examples. Then click on 2 tile in the middle panel to load the
simulation. Click on the book icon on the left (Example Simulations) panel to view documentation (pdf).

Support Learn Documentation Contact Us

Email - sales@tetcos.com
Phone - +01 767 605 4321
Website "

Figure 3-37: List of scenarios for the example of WSN StaticRoute

The following network diagram illustrates the network setup considered in this example:

—J L
SDN_Controller @

Wireless_Sensor_2 Wireless_Sensor_4

—== - Linkj‘ S i
- 1 = -
- " /, 1 b ‘\ S~ -
- - L4 A A * S~ -
‘?",»L’ ’,’1 : \1\ \}I\ » K‘\*E ’
~ i >
jag{ - , b . App1 SENSOR APP 'ﬁg{
L7 | 3 S
Wireless_Sensor_1 7 : 1 . Wireless_Sensor_5
2 | — w4
1
1
1
1
1
1

SinkNode_6

Figure 3-38: Network set up for studying the WSN StaticRoute

1. The following settings are done in the application layer properties of the devices for
configuring SDN:

Device Name Open Flow SDN Controller SDN Controller DeviceName
Wireless Sensor 1 Enable FALSE SDN Controller

Wireless Sensor 2 Enable FALSE SDN Controller

SDN Controller Enable TRUE NA

Wireless Sensor 4 Enable FALSE SDN Controller

Wireless Sensor 5 Enable FALSE SDN Controller

WSN Sink 6 Enable FALSE SDN Controller

Table 3-4: Set the properties for all the devices

2. Configure an application between any two nodes in the scenario by selecting an application
from the Set Traffic tab.
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a. Sensor Application from Wireless Sensor 1 to Wireless Sensor 5 with default Generation
Rate (Packet Size: 50Bytes, Inter Arrival Time: 1000000ps).
b. Set Transport Protocol to UDP.

3. Before Simulating the scenario, Right-click SDN Controller and click NetSim Console. Now,
the client (NetSimCLI.exe) waits to establish a connection with NetSimCore.exe.

B CAProgram Files\Met5im Prot\bin\MNetSimCLLexe

MetSim:

Figure 3-39: Connection Establishment.
a. Enable the packet trace from the Configure Reports tab and click on the Options tab and

select Run time interaction.

ﬁ File Options Help | Network: Internetworks | Workspace: 30ct2023

J§ Create| Open MATLAB Interface 11l Configure Reports % Show/Hide Info

Run Time Interaction

. | ——

B Save Static ARP Wired Node \~3) L2 Switch @ n\
- 5 o H

ﬂ Close A\ g Wireless Node ‘*, L3 Switch °

File Run Simulation Node Switch Access Point Router Wired/Wireless Links

Figure 3-40: Runtime Interaction in GUI
b. Inthe Run time Interaction tab, Set the Interactive Simulation option as True and click on
OK.

E: Runtime Interaction - u X

NetSim allows users to interact with simulations at runtime via command execution to
view/modify certain device parameters during runtime.

There are two options available for runtime interaction. Interaction can be set to be via a
socket or through a 'input.txt’ file in a predefined format.

This input.txt file accepts all the commands that NetSim's interactive simulation supports.

Interactive Simulation True v

File Name Input File Browse

OK Cancel

Figure 3-41: Runtime Interaction Window

c. Click on Run simulation window and simulate it to 500 sec.
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d. Simulation (NetSimCore.exe) starts to run. NetSimCore.exe displays

T NetSim - Run Simulation — X
Simulation Time
Enter desired simulation time. Valid range is 0.0001 to 100,000 seconds.

Simulation Time | 50q|

Seed Value
Enter seed value between 1 to 99,999,999. The seed values are used to generate random

numbers in simulation.

Seed 1 12345678 Seed 2 23456789

Run Cancel

Figure 3-42: Run Simulation Window

message: waiting for the first client to connect.

Ver 14.3

the following

B C\Users\ALICE\Documents\MNetSim\Workspaces\Fer_tail\bin_x64\NetSimCore.exe

3]/ INTERFACE/ LAYER[3]/

VICE[4]/INTERFAC

1/INTERFACE/LAVER[3]/

C To stop connection.

Figure 3-43: Waiting for Client to connect.

4. Observe the packet trace after simulation, you will see the direct communication between

wireless sensor 1 and 5.

PACKET_ID| ~ SEGMENT_ID - [PACKET_TYPE - | CONTROL_PACKET_TYPE/APP_NAME|-¥ SOURCE_ID ~ DESTINATION_ID - |TRANSMITTER_ID| ~ RECEIVER_ID ~

1

0N R WwN

0 Sensing Appl SENSOR_APP SENSOR-1  SENSOR-5
0 Sensing Appl SENSOR_APP SENSOR-1  SENSOR-5
0 Sensing Appl SENSOR_APP SENSOR-1  SENSOR-5
0 Sensing Appl SENSOR_APP SENSOR-1  SENSOR-5
0 Sensing Appl_SENSOR_APP SENSOR-1  SENSOR-5
0 Sensing Appl_SENSOR_APP SENSOR-1  SENSOR-5
0 Sensing Appl SENSOR_APP SENSOR-1  SENSOR-5
0 Sensing Appl SENSOR_APP SENSOR-1  SENSOR-5

SENSOR-1
SENSOR-1
SENSOR-1
SENSOR-1
SENSOR-1
SENSOR-1
SENSOR-1
SENSOR-1

SENSOR-5
SENSOR-5
SENSOR-5
SENSOR-5
SENSOR-5
SENSOR-5
SENSOR-5
SENSOR-5

Figure 3-44: Direct communication between node 1 and node 5 in packet Animation window

5. For the same example, configure static routes such that the packets will go through Wireless

Sensor 1 to Wireless Sensor 5 via SDN Controller. To configure the static routes in SDN

Controller for Wireless Sensor 1 follow the above step 3 as explained above
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6. Type the following commands on the NetSim CLI console, in the <DeviceName with Device

ID> route add <destination IP address> MASK <subnet mask> <gateway IP address>

<metric> if <interface #> format.

Wireless Sensor 1 route ADD 192.168.0.6 MASK 255.255.255.0 192.168.0.4 METRIC 1 IF 1
SDN Controller route ADD 192.168.0.6 MASK 255.255.255.0 192.168.0.6 METRIC 1 IF 1

7. Interpret the results.
Open Packet trace and filter the CONTROL PACKET TYPE/APP NAME to show only APP1
SENSOR APP, you will see that data packet flow from wireless sensor 1 to wireless sensor

5 through SDN Controller.

PACKET_ID ~ |SEGMENT_ID | ~ |PACKET TYPE ~ CONTROL_PACKET TYPE/APP_NAME

-7 SOURCE_ID | ~ | DESTINATION_ID | - | TRANSMITTER_ID |~ |RECEIVERID ~

9 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-5
10 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-5
11 0 Sensing Appl SENSOR APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-5
12 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
12 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
13 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
13 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
14 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
14 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
15 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
15 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
16 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
16 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
17 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
17 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
18 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
18 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5
19 0 Sensing Appl_SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-1 SENSOR-3
19 0 Sensing Appl SENSOR_APP SENSOR-1 SENSOR-5 SENSOR-3 SENSOR-5

Figure 3-45: Communication between Sensor 1 > SDN Controller > Sensor 5 in packet trace window

4 Latest FAQs

You can refer to the up-to-date FAQs about NetSim’s SDN library at

https://tetcos.freshdesk.com/support/solutions/folders/14000122307.
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